ADDENDUM NUMBER 1 TO FEATURE MANUAL
14221-7200-6110, REV. E

This addendum updates the second bullet in Section 4.2.2.
Current text:

e For CH-100 only, voice files must be transferred through the serial connection on the back of the
control head.

Change to:

o XG-100M radios only support programming Voice Annunciation files through the rear DB-9
connector of the radio.
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SAFETY CONVENTIONS

The following conventions may be used in this manual to alert the user to general safety
precautions that must be observed during all phases of operation, service, and repair of this
product. Failure to comply with these precautions or with specific warnings elsewhere in this
manual violates safety standards of design, manufacture, and intended use of the product.
L3Harris assumes no liability for the customer's failure to comply with these standards.

The CAUTION symbol calls attention to an operating procedure, practice, or the

like, which, if not performed correctly or adhered to, could result in a risk of

danger, damage to the equipment, or severely degrade the equipment
CAUTION performance.

G] The NOTE symbol calls attention to supplemental information, which may

improve system performance or clarify a process or procedure.
NOTE
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2. INTRODUCTION
2.1 FEATURE DESCRIPTION

The Voice Annunciation (VA) feature provides audible feedback for switch/knob changes. This
feature supports both “pre-recorded” (canned) messages, as well as, user-recorded messages.

2.2 RELATED DOCUMENTATION

Please refer to the Radio Personality Manager (RPM) or Radio Personality 2 (RPM2) on-line help
for additional information on Voice Annunciation.

Consult the maintenance manual for your radio for cables and programming information specific
to your radio model.
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COMPATIBILITY

3.1 SYSTEM COMPATIBILITY
Voice Annunciation is compatible with the following systems:
¢ Analog Conventional — Zone, Channel, and System Changes
e P25 Conventional — Zone, Channel, and System Changes
e P25 Trunked — Zone, Group, and System Changes
e EDACS®/ProVoice — Group and System Changes
o EDACS IP/ProVoice — Group and System Changes
3.2 TERMINAL COMPATIBILITY
3.2.1 Radio Models and Hardware Revision Support for Voice Annunciation
To support Voice Annunciation, the radio hardware must have at least 32 MB flash available. If
the necessary flash size is not present, the radio will display “VA HW ERR” message. See
Section 3.2.1.1 for instructions for finding the flash size. See the radio product label for the
Hardware Revision for the radio.
. . Hardware Revision
Family Band Split Type Part Number Supported
Scan RU-123550-003
P5300 800 MHz Rev. D or later
System RU-123550-004
Scan RU-123550-001 Use the procedure in
Section 3.2.1.1 to verify
P5400 800 MHz .
System RU-123550-002 that radio has 32 MB
flash
Scan RU-123550-041
P5300 900 MHz Rev. E or later
System RU-123550-042
Scan RU-123550-011
VHF Rev. E or later
System RU-123550-012
Scan RU-123550-021
P5400 UHF-L Rev. E or later
System RU-123550-022
Scan RU-123550-031
UHE-H Rev. E or later
System RU-123550-032
P5300 IQ All Bands N/A All Models No restrictions
P5500 All Bands N/A All Models No restrictions
Scan RU-012560-001 o
700-800 MHz No Restrictions
System RU-012560-002
P7300
Scan RU-013585-001
UHF-H Rev. C or later
System RU-013585-002
UHF-L RU-144750-021 Rev. C or later
M7300 UHF-H RU-144750-031 Rev. D or later
Or VHF N/A RU-144750-041 Rev. D or later
XG-75M* VHF (110 W) RU-144750-051 Rev. A or later
700/800 MHz RU-144750-061 Rev. J or later
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. . Hardware Revision
Family Band Split Type Part Number Supported
700/800 MHz RU-144750-061 Rev. J or later
M5300 N/A
900 MHz RU-144750-181 Rev. P or later
XG-15P* All Bands N/A All Models No Restrictions
XG-75P*
Or All Bands N/A All Models No Restrictions
XG-75Pe*
XG-25P*
Or All Bands N/A All Models No Restrictions
XG-25M*
XG-100P
Or All Bands N/A All Models No Restrictions
XG-100M*
XL Portables** All Bands N/A All Models No Restrictions

* If using RPM2 to program, requires RPM2 R3A or later.
** Can only be programmed using RPM2.

Older P7300 700/800 MHz and M7300 (with Flash size = 128 Mb) radios do not

support the VA feature.
NOTE

3.2.1.1 Reading the Radio Flash Size

The procedure is not applicable to XL radios.
NOTE

Use the following steps to read the flash size for the radio:

1. Connect the radio to a PC running RPM/RPM2. Make sure that the radio is in Programming
Mode.

Open RPM Radio Maintenance Utility.
Select the tab for the radio.
Select the Radio Information button. A screen similar to the one shown below is displayed:

Radio Status Information (Read Only) @I

ROM Serial # A4011000278A

Radio Type 0x77

Hardware Info Software Info
RF Board 800 Mhz Radio Software File Name RO4C01
Ram Size 2MB Personality Name ARMYCORPS1
Flash Size 16 MB I RPM SW Group # it
HardWare Board P5400 RPM Version # u
Flash SW Version = Ox1
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3.3

5. If the Flash Size shows 32 MB, then the radio supports Voice Annunciation.

3.2.2 Radio Software

The minimum radio software required to support Voice Annunciation is XGP R4A.

RADIO PERSONALITY MANAGER (RPM/RPM2)

RPM R11A and later supports Voice Annunciation. Voice Annunciation is not supported by any
other radio programming software such as ProGrammer or earlier revisions of RPM.

XL radios must be programmed with RPM2.
Programming XG radios with RPM2 requires RPM2 R3A or later.
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4.2

4.3

VOICE ANNUNCIATION COMPONENTS
AUDIO FILES

Voice Annunciation supports both pre-recorded (provided with RPM/RPM2) and user-recorded
messages.

These files must meet the following specifications:
e .ilbc 16 bit, 8 KHz sample rate or .wav 16 bit

e 8 KHz sample rate format

G] RPM/RPM2 automatically converts .wav files to .ilbc files. This process is
invisible to the user.

NOTE

e Contains no more than three (3) seconds of audio.
TERMINALS

421 OMAP Radios

RPM/RPM2 supports file transfer over a serial connection for OMAP radios.

4.2.2 Unity Radios

o RPM supports file transfer over a USB connection for most Unity radios.

o For CH-100 only, voice files must be transferred through the serial connection on the back of
the control head.

e On Unity radios, installed ASCII commands move files from the flash file system to/from the
RAM file system.

4.2.3 XL Radios

o RPM2 supports file transfer over a USB connection.

e Voice Annunciation is not supported over Wi-Fi.

RPM and RPM2

RPM or RPM2 is used to configure and write Voice Annunciation files to a radio. RPM/RPM2
also manages how Voice Annunciation functions and reads, extracts, and saves voice files from
a radio.

Voice Annunciation features for RPM:

¢ RPM/RPM2 maintains a mapping file that links the personality parameters to Voice files that
have been associated, in personality, to those associated ilbc audio files.

o RPM/RPM2 maintains a unique association between personality file and the mapping file used
to associate Voice files to that personality.

10
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RPM/RPM2 stores this unique association in both mapping file and personality, for
subsequent validation by the radio.

RPM/RPM2 supports the upload or download of voice files separate from personality upload
or download.

RPM/RPM2 supports the upload/download of a Single voice file or Multiple voice files.

RPM/RPM2 indicates to the user that there is a file transfer failure, when indicated by the
radio.

RPM/RPM2 will not continue to attempt to download files after the radio informs RPM that the
flash is full.

RPM/RPM2 allows loading of older versions of the software even after the voice files have
been loaded.

RPM/RPM2 supports sending a command to the radio to fetch the available flash size of the
radio. This is an internal operation; RPM does not display any information regarding this.

RPM/RPM2 supports sending a command to the radio to delete all the files in a given
directory.

11
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5.

5.1

CONFIGURATION

Configuration of Voice Annunciation is accomplished using a PC on which RPM or RPM2 is
installed. Perform the following tasks (Sections 5.1.1 through 5.1.5) in the order that they appear.

This procedure assumes that the audio files have been created and are available on the PC.
See Section 4.1 for more information about audio files.

RPM

5.1.1 Create and Manage Audio Config Files

Use the Voice Annunciation Configuration dialog to create and manage Audio Config Files. This
dialog is available from the Voice Annunciation selection on RPM’s menu bar. This dialog enables
the user to select and associate different Audio File programmable fields to the available audio
files. See Section 4 for more information about audio files.

The Menu Bar on the Voice Annunciation Configuration dialog is shown below. The File Menu
allows the user to create a new or open an existing Audio Config File. This menu also includes
Save, Save As, and Exit functions. The Edit menu items are the same as the Audio Files
Operation(s) buttons on the right side of the dialog box and they share the same functionality.
The Help Menu displays the version and copywrite date.

WVoice Annunciation Configuration I

File | Edit Help
New Ctri+MN
QOpen Ctrl+O l_
Sawve Ctrl+5S |
Save As  Cirl+Shift+5 —
Bxit Ctrl+E
- I

5.1.1.1 Create a New Audio Config File
Perform the following steps to create a new Audio Config File:
1. Select File > New from the Menu bar.

2. The New Audio Config screen is displayed.

New Audio Config | XS )

Config Mame : VACONFIG

OK | Cancel

12
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3. Enter the Config Name in the text box and click OK. Config Name field allows a maximum of
12 ASCII characters.

Voice Annunciation Configuration ‘ XS |

File Edit Help

Audio Config File Name : |\-"ACONFIG*

Audio Files List

Select | IndexMNo Audio File Name Audio File(s) Operation
I M_CHAN1

1

=

3 M_CHAN3
4 M_CHAN4
5 M_CHANS
6 M_GRP1
7

8

9

M_GRP2

M_GRP3
M_GRP4
Save
Select All

Clear Selection

TTTTTTTH

Done ‘ Help ‘

Click on +Add Files button to add Audio files to the Audio Config File.
Browse and select the .wav or .ilbc audio file(s).

RPM automatically converts .wav files to .ilbc files. This process is invisible to
the user.

NOTE

The files are shown on the dialog. RPM assigns an Index Number to each file.

To save all the selected files to the Audio Config File, click on the Select All button and then
click the Save button.

8. To delete or replace an audio file on the dialog, click the Select box to the left of the Index No
to select the file. Use the Delete or Replace buttons on the right side of the dialog to make
changes.

9. Select Save. After you have saved the audio file(s), a confirmation screen is displayed if the
save was successful.

The Audio Files Operations buttons on the right side of the dialog box share the
same functionality as the selections located on the Edit menu.
NOTE

13
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Voice Annunciation Configuration | =

0 VACONFIGVAC file saved successfully at
- CA\Users\Public\Documents\RadPersMgr\AudioData

OK

At this point, the Audio Config Files are not associated with a personality and
have not been written to the radio. They exist only on the PC.
NOTE

To open an existing Audio Config File, perform the following:
1. Select File > Open and search for the Audio Config File (.vac).

If there are audio files with the same name as the ones in the Audio and Config folder, a
message will be shown giving the user the option to overwrite existing audio files (with the
same name) when opening the VAC files. The message will be similar to the one shown:

=

Voice Annunciation Configuration 28

.

Opening VACONFIG VAC creates or overwrites audio files in the path:
'9' C-\Users\Public\Documents\RadPersMgriAudicDatal

Do you want to overwrite M_CHANT1.ILEC?

Yes Yes to Al No ‘ No to All |

The associated audio files are displayed on the dialog.

To delete or replace an audio file on the dialog, click the Select box to the left of the Index

No to select the file. Use the Delete or Replace buttons on the right side of the dialog to make
changes.

4. Use the Select All button and Save buttons to map the files to the Audio Config File.

G] At this point, the Audio Config Files are not associated with a personality and
have not been written to the radio. They exist only on the PC.
NOTE

14
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5.1.1.2 Replacing the Audio Config File

To replace the Audio Config File on the Voice Annunciation Options dialog, click the Browse
button to locate the new file.

An information screen is shown. The user must click Update to update the new Audio Config File
with the current list of audio files or click Clear to clear all the audio files throughout the

personality. Use Cancel to delete the new Audio Config File, discard changes, and close the
information screen.

Radio Personality Manager 28

lel Selecting 2 new Audio Config File alters the existing configuration.
Do you want to clear the older configuration or update the
existing configuration with the new configuration?

Update Clear ‘ Cancel |

5.1.2 Setting Up Default Path for Saving Audio Files (Optional)

To set the default path to save the Audio Config file and the Audio files, perform the following:

1. From the menu bar, select Tools = Options and Directory Settings.

= Radio Personalty Manager™ N

File Sets Radic View | Tools | Help

[ |[?E7| | | |@ Comm Settings...

Options and Directory Settings... |

Radio Settings...
Data Extractor
Sets Converter

2. On the Options and Directory Settings dialog, click the Browse button _| next to the Audio
and Config control to locate the desired directory path. If the user does not select a directory
path, a default directory will be created similar to a personality directory.

For example: “C:\Users\Public\Documents\RadPersMgr\AudioData”

15
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Options and Directory Settings ﬁ

I Rl (- U sers PublichD ocuments\H adPersM ar Global S ets

Perzonality: |E: WUzers\PublichDocumentz'A adPerstdgrtPerzonalities

Fadio Data: |E:"~L|sers"~F'uI:uIiu:"~D ocumnentzhA adPerstd grsB adbin

Backup: |E: W zers\PublichD ocumentztA adPerstdarhB ackup

Trewk: |E: Y zershPublichD ocumentshR adPerst arh Track

Audio and Config: |I::'xLlSers'xF'ul:uIi-:"-.DDcumentsHHadPersM arvdudioD ata

Enable File Backup: |+ Track Directories For Session: |
Enable SCS Files: [ Calculate Personality Size: [
Save Binamy Files: [ Use NPSPAC: W

Eit Program ode: | Only After WwWrite ﬂ

s | Cancel |

3. Click OK.

5.1.3 Configure VA Personality Settings

The user should open a new or existing personality prior to configuring the following settings.

5.1.3.1 Configure Voice Annunciation Settings

The Voice Annunciation Settings are in the Options - Voice Annunciation dialog. Use this
dialog to determine how the Voice Annunciation feature will operate. Please consult the RPM on-
line help for a description of all the controls on this dialog.

At a minimum, the Enable Voice Annunciation checkbox must be enabled and an Audio Config
File must be selected to use Voice Annunciation:

16
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Voice Annunciation | 2< |

[ Enable Voice Annunciation ¢

Priority 1 Priority 2 Priority 3
Alert Tones J | RxAudio J VA J

- . n ; .
Minimum Volume : v Maximum Volume 40

Select Audio Config File : Q—‘

Key Events

ENCRYPTION ON
ENCRYPTION OFF

H EHHEE ,E,EF Audio File:
NC ON

NC OFF Index:
SCAN ON

SCAN OFF

TALKAROUND ON

TALKAROUND OFF

TX DISABLED ON

TX DISABLED OFF

oK ‘ Cancel ‘

kL

The remaining options on this screen may be changed by the user or left at the default settings
per the desired configuration.

O Enable Voice Annunciation must be enabled (checked) to make changes to
any control on this dialog.

NOTE

will not play any voice files even if voice files have been configured/programmed
NOTE into the radio.

ﬁ If the Enable Voice Annunciation control is not enabled (checked), the radio

17
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5.1.3.2 Verbose Playback

Verbose Playback is an option that plays audio for all the applicable files that are associated with
an audio file.

If Verbose Playback is ON, the radio will voice annunciate all the current Zone (if applicable),
System, and Group/Channel. For example: If the user moves the Group knob, all the applicable
files (Zones), System, and Group/Channel are played back.

If Verbose Playback is OFF, the radio will announce only the last setting modified by the user. For
example: If the user changes the System key, only the System file is announced.

The radio plays the audio files in the following order: Zone, System, and Group/Channel. The gap
between these files is not greater than 100 ms.
5.1.3.3 Power On

Power On is an option that instructs the radio to announce the System, Group/Channel, or Zone
associated with an audio file when the radio boots up.

ﬁ Verbose Playback is applicable to this control.
NOTE

5.1.3.4 Audio Source Priority

These fields indicate the priority given to each audio source if they become available at the same
time. Tones are always given the Highest (1) priority and the user cannot change this.

e RxAudio is set to a higher priority (2) than VA (3): When the radio late enters to a group with
active Rx call and which has a voice file associated to it (VA is enabled), the radio interrupts
the voice playback with the Rx Audio.

o RxAudio is set to a lower priority (3) than VA (2): When the radio late enters to a group with
active Rx call and which has a voice file associated to it (VA is enabled), the radio continues
the voice playback and starts Rx Audio upon the completion of the VA.

O The radio interrupts playing the current audio file if a higher priority audio
source is available.

NOTE

Use the Browse button to select an Audio Config File.

5.1.3.5 VA Toggle Events

Use the VA Toggle Events controls to provide audible feedback for the events listed in this
dialog.

To configure a VA Toggle Event, perform the following:
1. Click to highlight a Key Event from the list.

2. Click the Select Audio button.

3. Click on the Audio File for the event. Click OK.

18
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-

Select Audio File

Index Audio File
No

M_CHAN1
M_CHAN2
M_CHAN3
M_CHAN4
M_CHANS
M_GRP1

M_GRP2

R =~ I I S L T

bl

Cancel |

Voice Annunciation |

4. The Audio File and the Index are shown on the dialog to the right of the Key Event.

=

|7 Enable Yoice Annunciation

—Voice Annunciation Settings

[ Enable Verbose Playback

[~ PowerOn
~Audio Source Priority
Priority 1 Priority 2 Priority 3
[aenTones  ~]  [ReAudio = va -]
~Volume Setting
Minimum Volume: |0 3: Maximum Volume : lﬂ

~Audio Caonfig File

Select Audio Config File :

IC:\Users\Public\Documems\RadPersM Browse |

VA Toggling Events
Key Events

ENCRYPTION OFF
MONITOR ON
MONITOR OFF

NC ON

NC OFF

SCAN OFF
TALKARGUND ON
TALKAROUND OFF
TX DISABLED ON
TX DISABLED OFF

ENCRYPTION ON

AudioFile:  [M_GRP4

Select Audio
Index: |9

ok | Cancel |

5. Repeat Steps 1-5 for each Key Event required.

6. Click OK to close the Voice Ann

unciation dialog.

19
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5.1.4 Adding Audio Files to a Personality

5.1.4.1 Enabling Voice Annunciation for Systems, Sets, and Zones

As you create the radio personality, you may enable Voice Annunciation on the following screens,
depending upon the configuration:

o General System

e Conventional Frequency Set

e P25 Conventional Frequency Set
e EDACS Group Set

o EDACS IP Group Set

e P25 Group Set

e Zones (Unity radios only)

The Voice Annunciation controls display, as shown below, on each of the dialogs. Select the
Audio File for the system, set, or zone and the Index will be populated by RPM. Click on the
Select Audio button to enable the Audio file. This must be enabled on every dialog for which
Voice Annunciation is desired.

Voice Annunciation

Audio File:
Select Audio
Index:

Voice Annunciation must be enabled on the Voice Annunciation Options
dialog to set these controls. See Section 5.1.3.1. Otherwise, these controls
HOTE will be grayed-out.

5.1.4.2 Enabling Voice Annunciation for A/B Switch for OMAP Radios

Voice Annunciation is enabled on the Portable Radio Keypads dialog located under Options.
Voice Annunciation can be enabled on the Portable Radio System dialog and the Portable Radio
Scan dialogs. The following A/B Switch events are applicable to the Voice Annunciation feature:

e Scan On/Off

e Talkaround On/Off

¢ NC (Noise Cancellation) On/Off

o PVT On/Off

This feature is applicable to P5300, P5400, P5500, P7300, and XG-75 radios.

20



14221-7200-6110, Rev. E

To enable Voice Annunciation for the A/B Switch, perform the following:

G] This procedure assumes that user has completed the tasks in Section 5.1.1
and Section 5.1.3.

NOTE

1. Select an event for Switch A. When a valid event has been selected, Select Audio (A) will
be enabled.

Click the Select Audio button and select the desired Audio File.
RPM will populate the corresponding Index.
Repeat Steps 1 through 3 for Switch B.

a > w DN

Click OK to save the changes.

5.1.4.3 Enabling Voice Annunciation for A/B Switch for Unity Portable Radios

Voice Annunciation is enabled on the Programmable Knobs dialog located under Options 2>
Programmable Buttons/Knobs/Shortcut Menu. The following A/B Switch events are
applicable to the Voice Annunciation feature:

e Encryption On/Off
Monitor On/Off

Tx Disabled On/Off
Talkaround On/Off
Keypad Lock On/Off
Scan On/Off

=

Voice Annunciation is not supported for the Three Position Switch (A/B/C).
NOTE

To enable Voice Annunciation for the two position (A/B) Switch, perform the following:

G] This procedure assumes that user has completed the tasks in Section 5.1.1

and Section 5.1.3.
NOTE

1. Use the dropdown box to select an A/B Switch event.
2. Click the Select Audio(A) button and select the desired audio file.

G] The Audio Config File must have been previously selected in the Voice
Annunciation Options dialog.

NOTE
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3. RPM will populate the audio file and the corresponding Index.

4. Repeat Steps 1 through 3 for Switch B.
5. Click OK to save the changes.

Portable Radio Keypads

Portable Radio Scan Keys

] Portable Radio SelectKeys
Ponable Radio System Keys

A

. [VOLUME |GRP

[Timon ~ ]

Voice Annunciation

Audio File: [M_GRP1
Index: |6

—
o

5.1.4.4 Enabling Voice Annunciation for Unity Mobile Radios with CH-100 and CH-721

The procedure to associate Voice Annunciation Key Events with Audio Files is the same for both
the Unity XG-100M with CH-100 or the CH-721. The Key Events available for these radios is

different.

The following Key Events can be associated with Audio Files for Unity Mobiles with CH-100:

e Encryption On/Off

e Monitor On/Off

e Tx Disabled On/Off
e Talkaround On/Off
o Keypad Lock On/Off
e Scan On/Off

The following Key Events can be associated with Audio Files for Unity Mobiles with CH-721.

e Encryption On/Off

¢ Noise Cancellation On/Off
e Talkaround On/Off

e Scan On/Off

~| |emer  ~|

Select Audio (A)

oo |

=

l

If a Key Event is selected and it is not available to be associated with an Audio
File, the Audio File controls with be grayed-out.
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To set up Voice Annunciation for these Key Events:

1. Select Options = Voice Annunciation. Voice Annunciation must be enabled.
Under VA Toggling Events, select the Key Event to be associated with an audio file.
Click on Select Audio and choose the audio file for that event.

Repeat Steps 2 and 3 for each Key Event for which an audio file is desired.

a M w DN

Click OK to save your changes or Cancel to discard your changes.

5.1.4.5 Stealth Mode Settings

If using Stealth Mode, Voice Annunciation can be enabled or disabled during Stealth Mode
operation. The default is disabled (unchecked). To enable Voice Annunciation for Stealth Mode
operation, click the checkbox as shown in the following figure.

Stealth Mode Options | P X |

| Persistence Enabled

[+ LCD Enabled

[ LED Enabled

[ Backlight Enabled

[ SidefAlert tones Enabled
-

[v" Woice Annunciation Enabled

Ok Cancel

Enabling of Voice Annunciation indicates to the radio that Voice Annunciation is affected by
Stealth Mode and the playing of voice files will be disabled during Stealth Mode.

When Stealth Mode is enabled and Voice Annunciation Enabled is checked on
this dialog, the radio disables playing of voice files, regardless of the VA

NOTE enable value set in the personality or in the Menu options.

5.1.4.6 Programmable Menu Settings for OMAP radios

A programmable button on the radio keypad can be configured to toggle Voice Annunciation On
and Off. This is applicable to OMAP radios and Unity XG-100M with CH-721. See Section 5.1.4.7
for the programmable menu configuration for other Unity Portable radios.

To program this function, perform the following in RPM:
1. Choose Options = Programmable Menus.
2. Select a Trunked and/or Conventional Key number.

3. Use the drop-down box to assign VA (Voice Annunciation) to that key.
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4. Click OK.
Programmable Menus -
Murnber Meru
Trunked Mernus: N W -
2 | -]
3
4 w

Corventional b enusz:

~ W |
TA9EN ~
v TALKARND

TIME

T3 POWER

e L D

Tabulariew | | OK  [ZERO DES

ZOME
#TMF 1

G] If the radio is programmed with a VA enable/disable menu option, the radio

overrides/overwrites the personality setting.
NOTE

5.1.4.7 Programmable Menu Settings for Unity Portable Radios

A programmable button on the radio keypad can be configured to toggle Voice Annunciation On
and Off. This is applicable to Unity XG-100P only.

To program this function, perform the following in RPM:

1. Select Options > Programmable Buttons/Knobs/Shortcut Menu.
2. Select the Programmable Shortcut Menu.

3. Select “On/Off Voice Annc” and click OK.
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Programmable Buttons/Knobs/Shortcut Menu &Iﬂ_hj

Programmable Buttons l Programmable Knobs ~Programmable Shorteut Menu ]

Pasition Name &
Start/Stop scan

=l
Start/Stop maonitor ﬂ

izance delste |
|On;"0ﬁ Voice Annc ﬂ
Wiew SA Display -
Select Unit to Individual Call

Select an Operator Selectable tane

Initiate OTAR rekey
Enable/Disable Talkaround Mode P

Select Channel/Group Mumber

Do nothing E
M

m

- - = I I = T+ I - S P B o I

—
=

Do nothing J

Do nathing - Default

—
—_

oK Cancel |

5.1.5 Program the Personality

After Voice Annunciation is configured, it is recommended that the personality is loaded into the
radio before loading the audio files.

Please refer to the specific maintenance manual for your radio and/or the RPM help files for more
information on programming a personality to a radio.

When a personality is downloaded and no audio files have been downloaded to
the radio, RPM displays a warning to remind the user to download the audio

5.1.6 Download Voice Annunciation File to Radio

After you have configured all audio files, use the Program Audio section of the Voice
Annunciation Management dialog to download the audio files to the radio. Radio connection
information differs depending on the radio type but, in most cases, the cables, connections, etc.,
used for programming a personality to a radio can be used to download the VA files.

e RPM supports file transfer over USB connection for the Unity portables.

e For Unity mobiles, voice files must be transferred through the serial connection on the back
of the radio.

e RPM supports file transfer over Serial connection for all other applicable radios.
See Section 3.2 for a list of radios/radio software which supports Voice Annunciation.
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5.1.6.1 Connect the Radio to the PC

Use the appropriate programming cable to connect the radio to the PC. For more information on
this cable, see the Installation and Configuration manual for your radio model or consult the RPM
on-line help.

If the connection from the PC to the radio is successful, the Radio Information section of the dialog
box is filled in.

e If connected via a Serial connection ¥ , click on the Discover Audio Files button to
display a list of the audio files available in the radio.

e |f connected via a USB connection o> , a list of the audio files available in the radio will be
displayed.
5.1.6.2 Select Files

Use the controls on the Program Audio tab, browse for the Audio Config File and its associated
audio files. Select the audio files that you want to program into the radio by clicking on the Select
box for the audio file.

Use the Select All button if all the audio files are desired.

Refer to the RPM on-line help for information on individual controls on this tab.

5.1.6.3 Write the Audio Files to the Radio

After the personality has been programmed into the radio and the desired audio files have been
selected, click the Program button on the Program Audio tab. This will write the selected audio
files to the radio. This Program action overwrites any previously existing Audio Config File in the
radio. The radio supports storing up to 310 encoded voice files.

Program Audio I Manage Radio I

Program Audio File Configuration
Select Audio Config File

|C:HUsersHPuincHDocumentslﬁadF’ersMgr‘.P.udioDataWACO Browse

Select Index Audio Files -~
1 M_CHANT
2 M_CHANZ
3 M_CHAN3
4 M_CHAN4
5
6

<«

1|7

<]

M_CHANS

M_GRP1

~
e e

Program

Select All ‘ Clear All |
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When an Audio Config File is programmed into a radio, it overwrites any
previous existing Audio Config File in the radio.
NOTE

5.2 RPMZ2

5.2.1 Setting Up Default Path for Saving Audio Files (Optional)

To set the default path to save the Audio Config file and the Audio files, perform the following:

1. From the menu bar, select Tools = Preferences.

2. Under Default Values, select Default Directories.

RPMZ preferences Q@ x

4 Default values

Radio Types Global Set - - - " " —
B B obal Sets  Ci\Users\Public\Documents\RPM2\GlobalSets [ .. |

“ Miscellaneous
General Personality | C:\Users\Public\Documents\RPM2\Personalities [ ]

Radic Firmware  C:\Users\Public\Documents\RPM2\Radbin ‘_l

Export | C\Users\Public\Documents\RPM2\ Export [ |

Audio and Config  C:\Users\Public\Documnents\RPM2\ AudicData [ ]

User Profile | C:\Users\Public\Documents\RPM2tUserProfile B

3. Click the Browse button & next to the Audio and Config control to locate the desired directory
path. If the user does not select a directory path, a default directory is created.

For example: “C:\Users\Public\Documents\RPM2\AudioData”
4. Click Apply.
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5.2.2 Create and Manage Audio Config Files

5.2.2.1 Create a New Audio Config File
Perform the following steps to create a new Audio Config File:
1. Display a new VAC tab:

> Click File & New = Voice Annunciation.
or

» Click @ and select Voice Annunciation.
or

> Click the * tab and select Voice Annunciation.

2. Atab opens allowing you to add audio files to the Audio Config File.

RPMZ Fie PRadio Jools Help G 0 B B X =S @ 5] © w = 0 X
=
-
] @ ] VACONFIGOOL* % + = x|
VACONFIG001 VAC Path Audio Files 0 )
g
o
S
Audio File List
Index Audio File(s)
& Errors ) | O Licenses | () AAC P25 Networks | @ Security Keys

3. Click Add Files to add audio files. Browse and select the .wav or .ilbc audio file(s).

RPM2 automatically converts .wav files to .ilbc files. This process is invisible to
the user.

NOTE

4. The files are shown on the dialog. RPM2 assigns an Index Number to each file.

28



14221-7200-6110, Rev. E

RPMZ File Radio Jools Help G d R = X S 0 £ © w - B

L] Q | 12456 x  + - x

smais §0 x

123456 VACPath  C:\Users\aprathertDesktop\123456. VAC Audio Files 72

dpH @

Audio File List

Index Audio File(s)

1 CHANMNEL_1
2 CHANNEL_2

CHANNEL_3
4 CHANNEL 4
5 CHANNEL 5

CHANNEL &
7 CHANNEL_7
8 CHANNEL 8
9 CHANNEL 9
10 CHANNEL_10
1 CHANNEL_11

@ Enors ) | O Licenses | () AACP2S Networks | ) Security Keys

5. To delete or replace an audio file, select the desired audio file(s), right-click and select Delete

or Replace. You can also click ™ to delete the selected audio file(s). To insert an audio file,
right-click and select Insert.

6. To save all the selected files to the Audio Config File, click File 2 Save, or File > Save As.

G] At this point, the Audio Config File is not associated with a personality and has
not been written to the radio. It exists only on the PC.
NOTE

To open an existing Audio Config File, perform the following:

1. Select File 2 Open = Voice Annunciation and search for the Audio Config File (.vac). The
file opens in a new tab.

2. To delete or replace an audio file, select the desired audio file(s), right-click and select Delete

or Replace. You can also click @ to delete the selected audio file(s). To insert an audio file,
right-click and select Insert.

G] At this point, the Audio Config File is not associated with a personality and has
not been written to the radio. It exists only on the PC.
NOTE

3. To save all the selected files to the Audio Config File, click File > Save, or File > Save As.
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5.2.3 Program and Manage Audio Files

1. Click Radio = Voice Annunciation or selectthe ¢ tab > = sub tab.

RPMZ Fie Radic Tools Help G d ] 9 2 0 £ 0 w - 0

smeis @0 | %

] @ ] + -

£\ 6| = - Voice Annuncistion o5 & G- @ Connections: 1 Audio Files: 72

dpH @

Connection MRU ESN Radio Name Radio Type (
< A40302000083 NA NONE XL-Portable Manage VA on the Radio
Discovered Audio Config File

VACONFIGO01.VAC !] EXTRACT AND SAVE

Manage audio files <
currently in the radio

Audio Files Exist in Config
CHANNEL L
CHANNEL_10
CHANNEL_11
CHANNEL_12
\| CHANNEL_ 13

7 Program Audio to the Radio

Select Audic Config File C:\Users\Public\Documents\RPh S8
il

a] Index  Audio File

Vi 1 CHANNEL1
CHANMEL 2

Program audio files <

% CHANNEL_3
to the radio

CHANNEL 4
CHANNEL_S
CHANNEL 6

& o e oW

-2 PROGRAM [ ]

.

Q Erors0) | OwLicenses | (1) AACP25 Networks | g Security Keys

Figure 5-1: RPM2 Voice Annunciation Tab

2. Under Program Audio to the Radio, click & to browse to the desired Audio Config File. Al
audio files associated with the Audio Config file are displayed.

Select the desired audio file(s) and click PROGRAM.
Manage audio files programmed to the radio from the Manage VA on the Radio field. From
here, you can extract audio files and delete audio files.

5.2.4 Configure VA Personality Settings

Open an existing personality or create a new personality.

5.2.4.1 Configure Voice Annunciation Settings

The Voice Annunciation Settings are in the Options - Voice Annunciation dialog. Use this
dialog to determine how the Voice Annunciation feature operates. Please consult the RPM2 on-
line help for a description of all the controls on this dialog.

At a minimum, the Voice Annunciation checkbox must be checked and an Audio Config File
must be selected to use Voice Annunciation:
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Voice Annunciation Settings

Voice Annunciation [

Voice Annunciation Settings
Enable Verbose Playback [
Power On |4
Audio Source Priority
Priority 1 [ ]
Pricrity 2 RxAudio
Priority 3 v
Volume Settings
Minirmurn Volume g
Maximum Volume  1g

Audio Config File

Select Audio Config File ChUsers\PubliciDocuments\RPM2\AudioData\VACONFIGL |ap

The remaining options on this screen may be changed by the user or left at the default settings
per the desired configuration.

Voice Annunciation must be enabled (checked) to make changes to any
control on this dialog.

=

NOTE

If the Voice Annunciation control is not enabled (checked), the radio will not
play any audio files even if audio files have been configured/programmed into
NOTE the radio.

=

5.2.4.2 Verbose Playback

If Verbose Playback is enabled, the radio will voice annunciate all the current Zone (if applicable),
System, and Group/Channel. For example: If the user moves the Group knob, all the applicable
files (Zones), System, and Group/Channel are played back.

If Verbose Playback is disabled, the radio will announce only the last setting modified by the
user. For example: If the user changes the System key, only the System file is announced.

The radio plays the audio files in the following order: Zone, System, and Group/Channel. The gap
between these files is not greater than 100 ms.
5.2.4.3 Power On

Power On is an option that instructs the radio to announce the System, Group/Channel, or Zone
associated with an audio file when the radio boots up.
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(i)

Verbose Playback is applicable to this control.

5.2.4.4 Audio Source Priority

These fields indicate the priority given to each audio source if they become available at the same
time. Alert Tones are always given the Highest (1) priority and the user cannot change this.

o By default, RxAudio is set to a higher priority (2) than VA (3): When the radio late enters to a
group with active Rx call and which has a voice file associated to it (VA is enabled), the
radio interrupts the voice playback with the Rx Audio.

e By default, RxAudio is set to a lower priority (3) than VA (2): When the radio late enters to a
group with active Rx call and which has a voice file associated to it (VA is enabled), the
radio continues the voice playback and starts Rx Audio upon the completion of the VA.

(i)

The radio interrupts playing the current audio file if a higher priority audio
source is available.

5.2.45 VA Toggle Events
Next to the Toggling Key Event (e.g., SCAN ON/SCAN OFF), select the desired Audio File from

the drop-down.

VA Toggling Events

ENCRYPTION ON
ENCRYPTION OFF
MONITOR ON
MONITOR OFF
NC OMN

MNC OFF

SCAN ON

SCAN OFF
TALKAROUND ON
TALKAROUND OFF
TX DISABLED ON

TX DISABLED OFF

Key Events Audio File
38 PRIVACY_ON

37 PRIVACY_OFF

36 MNOISE_CAN_ON

w
)

MNOISE_CAN_OFF

40 SCAN_ON

39 SCAN_OFF
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5.25 Adding Audio Files to a Personality

5.2.5.1 Enabling Voice Annunciation for Systems, Sets, and Zones

As you create the radio personality, you may enable Voice Annunciation on the following screens,
depending upon the configuration:

¢ Systems (Conventional, EDACS, EDACS IP, P25 Conventional, and P25 Trunked)

e Sets (Conventional, EDACS Group, EDACS IP Group, P25 Group, and P25 Conventional
Frequency)

e Zones

The Voice Annunciation controls display on each of the dialogs. Select the Audio File for the
system, set, or zone from the Voice Annunciation drop-down. This must be selected on every
dialog for which Voice Annunciation is desired.

Voice Annunciation must be enabled in OPTIONS - Voice Annunciation to
set these controls; see Section 5.1.3.1. Otherwise, these controls are grayed-

NOTE out.

5.2.5.2 Enabling Voice Annunciation for A/B Switch for OMAP Radios

Voice Annunciation is enabled on the Portable Radio KeyPads dialog located under OPTIONS.
Voice Annunciation can be enabled on the Portable Radio System Keys dialog and the Portable
Radio Scan Keys dialog. The following A/B Switch events are applicable to the Voice
Annunciation feature:

e Scan On/Off

e Talkaround On/Off

e NC (Noise Cancellation) On/Off

o PVT On/Off

This feature is applicable to P5300, P5400, P5500, P7300, XG-75, and XG-75Pe radios.

To enable Voice Annunciation for the A/B Switch, perform the following:

ﬁ This procedure assumes that the user has completed the tasks in Section
5.1.1 and Section 5.1.3.
NOTE

1. Select an event for Switch A. When a valid event has been selected, Voice Annunciation
(A) will be enabled.

2. Select the desired Audio File from the Voice Annunciation (A) drop-down.
3. Repeat Steps 1 and 2 for Switch B.
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5.2.5.3 Enabling Voice Annunciation for Unity Mobile Radios with CH-100 and CH-721

The procedure to associate Voice Annunciation Key Events with Audio Files is the same for both
the Unity XG-100M with CH-100 or the CH-721. The Key Events available for these radios is
different.

The following Key Events can be associated with Audio Files for Unity Mobiles with CH-100:
e Encryption On/Off

Monitor On/Off

e Tx Disabled On/Off

e Talkaround On/Off

o Keypad Lock On/Off

e Scan On/Off

The following Key Events can be associated with Audio Files for Unity Mobiles with CH-721.
Encryption On/Off

Noise Cancellation On/Off
Talkaround On/Off
Scan On/Off

To set up Voice Annunciation for these Key Events:

1. Select OPTIONS - Voice Annunciation. Voice Annunciation must be enabled.

2. Under VA Toggling Events, select the Audio File to associate with the desired Key Events.

5.2.5.4 Stealth Mode Settings (OMAP Portables)

If using Stealth Mode, Voice Annunciation can be enabled or disabled during Stealth Mode
operation. The default is disabled (unchecked). To enable Voice Annunciation for Stealth Mode
operation, click the checkbox as shown in the following figure.

34



14221-7200-6110, Rev. E

Stealth Mode Options
Persistence Enabled
LCD Enabled [«
LED Enahled
Backlight Enabled
Side/Alert tones Enabled
Mabile Main Audio Path Enabled d

Voice Annunciation Enabled  [&

5.25.5 Programmable Button Settings for XL Radios

A Programmable Button can be configured to enable/disable Voice Annunciation on XL Radios
by performing the following:

1. Choose OPTIONS - Programmable Buttons.
2. Select Voice Announcement Toggle for the desired button.

Programmable Buttons Option

Name Operation
Top Side Button Monitor/Clear 0.00
Middle Side Button Zone Up 0.00
Bottomn Side Button Zone Down 0.00
Emergency Emergency
Key 0 Mo function 0.00
Key1 System Up 0.00

System Down
Key 2 0.00
System Up Wrap
(572 System Down Wrap 0.00
Key 4 Talkarcund/Repeater Toggle 0.00
Top Backlight Mode

Key 5 0.00
TX Power High/Low Toggle

Key6 View SA Display 0.00
Key 7 Voice Announcement Toggle 0.00
one up
Key & 0.00
Zone Up Wrap
ksl Zone Down 0.00
Key Hash Zone Down Wrap 0.00
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5.25.6 Programmable Menu Settings for OMAP and XG-100M/CH-721 Radios

A Programmable Menu selection can be configured to toggle Voice Annunciation On and Off.
This is applicable to OMAP radios and Unity XG-100M with CH-721. See Section 5.1.4.7 for the
programmable menu configuration for other Unity Portable radios.

To program this function, perform the following in RPM2:
1. Choose OPTIONS = Programmable Menus.

2. From the drop-down box, assign VA to the desired menu location.

Programmable Menus

Menu # Trunked Menu Conventional Menu

1 BACKLGHT BACKLGHT

2 KEV LOCK SIS0

CONTRAST
S¥S SCAN

4 REVISION TO9EN

5 TX POWER TALKARND
TIME

PROGRAM
TXPOWER

7 INDYV

8 PHONE
ZONE
i ALARM ZONE1
z
10 EXT SPKR ZONE 2

11 PUB ADDR HEED

12 KEY LOAD PROFILE

If the radio is programmed with a VA enable/disable menu option, the radio
overrides/overwrites the personality setting.

5.2.6 Program the Personality

After Voice Annunciation is configured, it is recommended that the personality is loaded into the
radio before loading the audio files.

Please refer to the specific maintenance manual for your radio and/or the RPM2 help files for
more information on programming a personality to a radio.

When a personality is downloaded and no audio files have been downloaded to
the radio, RPM displays a warning to remind the user to download the audio
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5.2.7

Download Voice Annunciation File to

Radio

After you have configured all audio files, use the Program Audio to the Radio section of the
Voice Annunciation dialog to download audio files to the radio. Radio connection information
differs depending on the radio type but, in most cases, the cables, connections, etc., used for
programming a personality to a radio can be used to download the VA files.

RPMZ Ffie Radio JIools Help G d =k X

g +

£] © o J  VoiceAnnunciaion [BS8 7 -E- @

Connection MRU ESN Radio Name Radio Type

*% A40302000083 NA NONE XL-Portable

Manage audio files
currently in the radio

Z

L = @

g 0 w - o

X

snjels au

Connections: 1 Audio Files: 72

dpH @©

d - Discover VA
)
Manage VA on the Radio
Discovered Audio Config File

VACONFIG001.VAC

- EXTRACT AND SAVE
Ll |

Audio Files Exist in Config
CHANNEL_1
CHANNEL_10
CHANNEL_11
CHANNEL_12

CHANNEL_13

¢~ Program Audio to the Radio
Select Audio Config File C:\Users\Public\Documents\RPh 58
=
8 Index Audio File
Wl 1 CHANNEL1
o i 2 CHANNEL_2
Program audio files
. 3 CHANNEL_3
to the radio
4 CHANNEL_4
5 CHANNEL_S
[ CHANNEL_6
@ Erors(0) | O Licenses | () AAC P25 Networks | (@ Security Keys

RPM2 supports file transfer over USB connection for the XL Portables.

G] Voice Annunciation is not supported over Wi-Fi.

NOTE

For Unity mobiles, voice files must be transferred t
of the radio.

hrough the serial connection on the back

For CH-100, voice files must be transferred through the serial connection on the back of the

control head.

RPM2 supports file transfer over serial connection

for all other applicable radios.

See Section 3.2 for a list of radios/radio software which supports Voice Annunciation.
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5.2.7.1 Connect the Radio to the PC

Use the appropriate programming cable to connect the radio to the PC. For more information on
this cable, see the maintenance manual for your radio model or consult the L3Harris Products
and Services catalog.

If the connection from the PC to the radio is successful, the Radio Information section of the dialog
box is filled in. Click on the Discover VA button to display a list of audio files available in the
radio.

5.2.7.2 Select Files

Click & in the Program Audio to the Radio field and browse for the desired Audio Config File.
Select the audio files that you want to program into the radio by checking the box next to the audio
file or check the Audio Files checkbox to select all audio files.

Refer to the RPM2 on-line help for information on individual controls on this tab.

5.2.7.3 Write the Audio Files to the Radio

After the personality has been programmed into the radio and the desired audio files have been
selected, click the PROGRAM button in the Program Audio to the Radio field. This writes the
selected audio files to the radio. This action overwrites any previously existing Audio Config File
in the radio. The radio supports storing up to 310 encoded voice files.

Program Audio to the Radio

Select Audic Config File  C\Users\Public\Documents\RPh :
+| Index  Audio File
# 1 CHAMNMNEL_1
. CHAMMEL_2
“ 3 CHAMMEL_3
A CHAMMEL_4
4 5 CHAMNNEL_5
“ 6 CHAMMEL_6
o 7 CHAMNMNEL_7
“ 8 CHAMMEL_&
9 CHAMNNEL_ 9
~ 10 CHAMNNEL_10

~ 11 CHAMMEL_ 11

WAlT2 CHARME 13

When an Audio Config File is programmed into a radio, it overwrites any
previous existing Audio Config File in the radio.
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MANAGE AUDIO FILES FROM A RADIO

RPM

Use the Manage Radio Tab controls to read, extract, delete, and save audio files from a radio.

Voice Annunication Management

Radio Information

Port Serial Firmware N
Connection . Success Al
Name Number Version 7]
Discover Audio Files
Program Audio Manage Radio
Discovered Audio Files Radio Operations
Select Audio Files BB
Config
Format Flash Drive
SelectAll Clear All
Discovered Audio Config File
MNone Extract and Save
Dane Help ‘

6.1.1 View Audio Files from a Radio

To view audio files stored in a radio:
1. Connect the radio to the PC running RPM. See Section 5.1.6.1.

2. Click on the Discover Audio Files button for radios with a serial connection. The Discovered
Audio Config File is displayed and the audio files are listed in the Discovered Audio Files list.
When connecting to radios with a USB connection, the audio files are shown when the

connection is made.
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6.1.2 Select Audio Files to Save

Select the audio files by clicking on the Select box for the audio file. Use the Select All button if
all the audio files are desired. Use the Delete Audio Files(s) button to delete a selected audio
file(s).

For radios connected via a serial port, the list of files will not be automatically
refreshed when Delete Audio File(s) button is selected. Press Discovered

NOTE Audio Files button to see the changes.

Refer to the RPM on-line help for information on individual controls on this tab.

6.1.3 Extract and Save Audio Files

e Use the Extract and Save Audio File(s) button to save the selected audio files to a disk.

e Use the Extract and Save button to save the Discovered Audio Config File to a disk.

6.1.4 Formatting the Flash Drive

The Format Flash Drive button erases all contents of the flash drive and should be used ONLY
in cases in which the audio files are corrupt. This button is applicable to OMAP radios only.

This button should be used with caution. Clicking on this button is NOT the

same

as choosing the Select All button and clicking on the Delete Audio Files
CAUTION button.
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6.2 RPM2

Use the Manage VA on the Radio field on the Voice Annunciation sub-tab to read, extract, delete,
and save audio files from a radio.

 Disc
= —

Manage VA on the Radio

Discovered Audic Config File

Audio Files Exist in Config

6.2.1 View Audio Files from a Radio
To view audio files stored in a radio:
1. Connect the radio to the PC running RPM2. See Section 5.2.7.1.

2. Click on the Discover VA button. The Discovered Audio Config File is displayed and the
audio files are listed in the Audio Files list.
6.2.2 Select Audio Files to Save

Select (check) the desired audio files. Check the Audio Files checkbox to select all audio files.
Click T to delete a selected audio file(s).

Refer to the RPM2 on-line help for information on individual controls on this tab.

6.2.3 Extract and Save Audio Files

o Click the EXTRACT AND SAVE button to extract and save the selected Audio Config file to
a disk.

e Click the B button to extract and save the selected audio files to a disk.
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6.2.4 Formatting the Flash Drive

The FORMAT FLASH DRIVE button erases all contents of the flash drive and should be used

ONLY in cases in which the audio files are corrupt. This button is applicable to OMAP radios
only.

This button should be used with caution. Clicking on this button is NOT the

same

as choosing the Select All button and clicking on the Delete Audio Files
CAUTION  button.
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OPERATION

When the Voice Annunciation feature is configured and programmed into the radio, audible
feedback is heard when a VA configured knob/switch is changed.

e General
0 The volume of the audio file playback is determined by the Minimum and Maximum
settings on the Voice Annunciation Option dialog. This is independent of the radio volume
settings.
o If the radio is programmed with a VA enable/disable menu option, the radio user can
enable or disable the Voice Annunciation feature.
0 The radio support compatibility with personalities that do not support the Voice
Annunciation feature.
o Playing of VA files will not prevent over-the-air transmission of DTMF and Type 99 tones.
o The radio plays the VA files when the radio is powered-up if the Power On control is
enabled on the Voice Annunciation Options dialog.
e Priority

The radio interrupts playing the current audio file if a higher priority audio source (i.e.,
emergency) is available.

e Special Features

(0]

(0]

If Verbose Payback is enabled, all the Zone, System, Group/Channel audio feedback files
are heard whenever any one of these events occur. These will be heard in the order listed
in the previous sentence.

When Stealth Mode is enabled and Voice Annunciation is enabled in Stealth Mode
Options, the radio disables the playing of voice files regardless of the setting of the VA
Enabled value.
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8.

TROUBLESHOOTING

The chart below lists some operational issues and possible causes:

No Voice Annunciation
from the radio

Voice files are not loaded into radio.

Voice files are not associated with the personality.
Voice files are corrupt.

Radio is in Stealth Mode.

Voice Annunciation is disabled at the radio via a
Menu key.

Cannot write audio files to
aradio

Radio flash is full.
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TECHNICAL SUPPORT

The Technical Assistance Center's (TAC) resources are available to help with overall system
operation, maintenance, upgrades, and product support. TAC is the point of contact when
answers are needed to technical questions.

Product specialists, with detailed knowledge of product operation, maintenance, and repair
provide technical support via a toll-free (in North America) telephone number. Support is also
available through mail, fax, and e-mail.

For more information about technical assistance services, contact your sales representative, or
contact the Technical Assistance Center directly at:

North America: 1-800-528-7711
International: 1-434-385-2400
Fax: 1-434-455-6712
E-mail: PSPC_tac@I3harris.com
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